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ABSTRACT 

Reformer tubes are designed to last at least 100,000 hours (11.4 years) of operation, but 

frequently, some of the tubes in the furnace fail prematurely. Most of the failures occur 

due to the high temperature and pressure developed within the tubes. Thus, the use of 

Finite Element Analysis (FEA) software to model, simulate and draw meaningful 

conclusion from the actual process conditions of the reformer tubes can reveal important 

information regarding the mechanical and thermal stress response. The main objective of 

this project is to simulate the combined stress and temperature profiles developed within 

the reformer tube. This project involves modeling the mechanical and thermal loadings 

present in the tube as well as simulating the stress distribution across the tube's thickness 

and length. FEA using ANSYS utilized to analyze stress and temperature profile of the 

tube. Literature review of reformer tube has been performed and data needed has been 

identified. Stresses have been computed using ANSYS and verified with theoretical 

value. It has been seen that the temperature difference across the tube length resulted 

from the non-unifonn heat transfer coefficient can be considerable causing high thermal 

stresses. Maximum von mises stress equal to 142.61 MPa developed at the inner surface 

of the entrance region. The stress then compared with the tensile strength of the tube and 

it is showed that the tube is able to sustain the stress without fracture. 
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CHAPTER! 

INTRODUCTION 

1.1 Project Background 

The steam reforming furnaces are used to convert a process gas mixture (or 

simply called feedstock) of hydrocarbons and steam into hydrocarbon-rich gases which 

are used in the manufacture of methanol, ammonia etc. In all cases however, the 

feedstock is passed through reformer tubes which are filled with catalyst and, since heat 

is required to maintain the important endothermic reactions, the outsides of the reformer 

tubes are heated by burners in a large fire box, to temperatures in the range 875-1 000°C. 

Simultaneously, the feedstock is maintained at a high internal pressure in the tube [I]. 

Finite element analysis using ANSYS will be employed in this project. Finite 

element analysis (FEA) is a computer simulation technique used in engineering analysis. 

A common use of FEA is for the determination of stresses and displacements in 

mechanical objects and systems. Finite element software will be used to compute 

stresses caused by pressure, thermal and mechanical loadings. 

1.2 Problem Statement 

Reformer tubes used in steam methane reforming furnace operate under very 

aggressive conditions and are designed to withstand the combination of high metal 

temperatures, internal pressure and corrosion for an operational life of 8-12 years, 

depending upon the type of furnace and the method of operation. They are subjected to 

high temperature and pressure conditions in varying manners. 1n these conditions, the 
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material properties are highly dependent on the temperature profile which in tum 

influences the stress response of the tube. 

The temperature distribution in a part can cause thermal stress effects (stresses 

caused by thermal expansion or contraction of the material). Examples of this 

phenomena include interference fit processes (also called shrink or press fit, where parts 

are mated by heating one part and keeping the other part cool for easy assembly) and 

creep (permanent deformation resulting from prolonged application of a stress below the 

elastic limit, such as the behavior of metals exposed to elevated temperatures over time) 

[2]. 

As an example, reformer tubes from a fertilizer plant made of modified HK 40 

steel which failed after 4 years service were investigated for failure mechanism and life 

evaluation. Analysis revealed that longitudinal cracks found in the tubes were caused by 

overheating because of inadequate feed flow caused by the choking of damaged catalyst. 

At the time of failure the reformer was being started up with only 60 burners firing in 

the reformer. The gas in the catalyst tubes was mainly hydrogen and steam at a pressure 

of 3 kg/cm2 only. A total of seven tubes ruptured in the bottom portion in one comer of 

the radiant chamber. Another two tubes ruptured away from this zone in the bottom 

portion. The rupture was longitudinal. These tubes had been operation for 2 years. 

Dimensional measurements of the failed reformer tubes are shown in Table 1 (see 

Fig. 1 ). [3) 

Analysis on stress distribution of reformer tube is chosen to be the subject for 

this project due to its important application industry. Reformer tubes are extremely 

important component in reformer which is at the heart of any methanol plant and 

represents the largest capital expenditure unit operation and also is the largest energy 

user on the plant. The purpose of this project is to conduct a detailed simulation of the 

reformer to determine the pressure and temperature profiles axially along the tube. From 

this information, the stress being applied to the tube can be calculated and then, using 

the allowable stress-temperature data for the chosen material, the design temperature for 

the tube can be calculated. Thus, the combined stress and temperature profiles 
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developed within the tube are important data for the assessment of the material 's 

integrity 

Table 1: Dimensional measurement of the failed refonner tubes and theu 

measured crack lengths [3]. 

Tube no. Crn.ck length (rum) Max. OC (rum) Crack !e:tgth (rum) L (nm)3 t1g tail di~kr (mm) 
144 85~ 169 19 470 4~.4 

143 57) 160.7 1!.4 615 42.4 
142 88) 159 16 63C 4~.5 
14] 63J 158 17 87C 4~.1 
140 62J 158.6 13 860 42.~ 

139 63) 157 4 10 87C 4~.~ 

138 501 156.9 11.5 ;so 4;.2 
1jl ~m 15{9 10 1~10 4~. ~ 
1~1 600 155.~ llOO 4:! 1 

Fig. I: Photograph of nine failed tubes, as rece1ved [3] 
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1.3 Objectives 

The main goal of this project is to simulate the combined stress and temperature 

profiles developed within the reformer tube. For these complex loadings, numerical 

analysis can be employed to simulate the conditions. 

The objectives are: 

• To model the mechanical and thermal loadings present within the tube. 

• To simulate stress distribution across the tube's thickness and length. 

• To draw a meaningful conclusion based on the numerical analysis on 

completion of the project. 

1.4 Scope of Work 

This is a computational simulation project where the stresses and temperature 

profile of reformer tube will be simulated. Computer simulation is the discipline of 

designing a model of an actual or theoretical physical system, executing the model on a 

digital computer, and analyzing the execution output. Therefore the scopes of work for 

this project are: 

Scope of work: 

1) Perform literature review on reformer tube as well as finite element analysis 

techniques. 

2) Find the raw data (temperature profile and loadings) for reformer tube. 

3) Model the mechanical and thermal loadings present in the tube. 

4) Simulate the stress and temperature distribution across the tube's thickness 

and length. 

5) Analyze and conclude the results. 
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CHAPTER2 

LITERATURE REVIEW 

2.1 Reviews on Past Research Works 

The evaluation of stresses in a thick cylinder pressure vessel such as reformer 

tube is important for principal design consideration. Therefore, many investigators have 

directed their effort to study the pressure vessels in order to predict the required working 

capacity. Sinha [4] used the finite element method to analyze thermal stresses and 

temperature distribution in a hollow thick cylinder subjected to steady state heat flow in 

the radial direction. 

The study of pressure vessels subjected to both internal pressure and temperature 

was carried out by many researches. Naga [ 5] presented a close insight into stress 

analysis and optimization of both thick walled impermeable and permeable cylinders 

under the combined effect of stationary temperature and pressure gradients. Gunha [ 6] 

calculated the radial and hoop stresses conditions of a specified location within the wall 

of a cylindrical component configuration. Considerable loads were induced by constant 

pressure, steady state logarithmic temperature gradients and centrifugal body force [7]. 

2.2 Theories 

2.2.1 Steam-gas Reformer's Process 

The steam-gas reformer is a common but critical piece of equipment in ammonia 

and methanol plants. In most plants, methane is used as feedstock. It reacts with steam 

in catalyst-packed tubes at high temperature. The process is highly endothermic. The 
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tubes have inside diameters of 60-120 mm (2.5 in.) and are 10-14 m (33-46 ft.) long. 

The pressure is 15-30 bar (218-435 psi) and the temperature between 900 to 1000°C 

(1652-1832°F). The tube wall thickness ranges from 8 to 20 mm (0.31-0.79 in.) 

depending on the tube diameter, temperature and pressure. Excess steam is used to 

reduce the formation of carbon. The reforming reactions are favored by high 

temperature but retarded by high pressure [8]. 

2.2.2 Properties of Reformer Tube 

Due to prolonged exposure to high temperature, the microstructure of the 

material is subjected to degradation. For example, in the early stages, precipitation of 

carbides occurs. Following this, there is reduction in strength and embrittlement due to 

coalescence and coarsening of the carbides. Further degradation might lead to creep 

cavitations damage, micro cracking and final propagation of macro-cracks leading to 

catastrophic failure. 

Through researches that have been made, it is known that there has been a great deal of 

development in the area of tube metallurgy in the last 50 years, first with the 

introduction of centrifugally cast tubes in the 1950s, moving through to the introduction 

ofHK40 in the early 1960s and then on to the HP modified tubes in the mid-1970s and 

finally the HP micro-alloys in the mid-1980's [9]. The following table illustrates the 

development of the metallurgy with time. 

Table 2: Metallurgy developments of reformer tube [9]. 

Date Common Cr Ni Nb Others Relative 

name % % % 
strength 

1960s HK40 25 20 - - 1.0 

1970s IN 51 25 24 1 - 1.4 

Mid-1970s HPMod 25 35 1 - 1.9 

Mid-1980s HP Micro-alloy 25 35 1 Ti, Zr, W, Cs 2.2 
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Traditionally, HK40 alloy were used in the construction of reformer tube due to its creep 

rupture strength. With moderately high temperature strength, oxidation resistance and 

carburization resistance the alloy is used in a wide variety of industrial applications [10]. 

IN 51 is the same as HK 40 but with enhanced high temperature resistance up to I 025 C. 

The microstructural ofiN519 has improved the creep strength and ductility of the 

material [11].Common versions ofHP grade alloy are the HP40 which have improved 

high temperature strengths, and thus better resistant to thermal stresses and thermal 

cycling plus superior performance in both oxidizing and carburizing atmospheres [11]. 

It has much higher creep-rupture strength, carburization resistance and oxidation 

resistance than HK 40 alloy and consequently is used at higher service temperatures 

[10].Current trend, the preferred tube materials are the so-called 'microalloys' which 

further enhance the high temperature properties of the reformer alloy [II]. 

Figure 2 schematically presents the process conditions along the length of a catalyst 

tube. Process gas and steam typically enter each reformer tube between 450 and 500°C 

and exit at about 850°C, with a slight pressure drop down the length of the tube. The 

tube metal skin temperature varies along the length of each tube and reflects the design 

of the unit, the firing configuration and the required process conditions. The thermal 

through-wall temperature gradient is greatest towards the inlet end of a tube while the 

effective creep temperature (mean wall temperature) is highest towards the outlet end of 

the tube [12]. 
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Fig. 2: Typical axial profiles of tube skin, inner wall and process temperatures, 

process pressure and heat flux along a steam reformer catalyst tube [12]. 
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Solutions for the elastic and steady state stress profiles through the wall of a tube subject 

to thermal and pressure loadings are well established. Fig. 3 and Fig. 4 show the 

principal stress components on elastic loading and after a steady state have been 

achieved, for a typical reformer tube. The difference in magnitude between the elastic 

and steady state stresses is noteworthy. Modelling the evolution from the former state to 

the latter, even for a simple axisymmetric component, requires numerical solution [12]. 
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2.3 Heat Transfer Principle 

The reforming reaction is endothermic. In conventional reformers, the necessary heat for 

the reaction is supplied from the environment outside the tubes usually by a combination 

of radiation and convection to the outer side of the reformer tube. The heat is transferred 

to the inner side of the tube by heat conduction through the tube wall and is transferred 

to the gas phase by convection. Finally, the heat is transferred from the gas phase to the 

catalyst pellet by convection [14]. 

Heat conduction or thermal conduction is the spontaneous transfer of thermal energy 

through matter, from a region of higher temperature to a region of lower temperature, 

and acts to equalize temperature differences. Thermal energy, in the form of continuous 

random motion of the particles of the matter, is transferred by the same coulomb forces 

that act to support the structure of matter, so can be said to move by physical contact 

between the particles. 

Convection is one of the major modes of heat transfer and mass transfer. In fluids, 

convective heat and mass transfer take place through both diffusion- the random 

Brownian motion of individual particles in the fluid - and by advection, in which matter 

or heat is transported by the larger-scale motion of currents in the fluid. In the context of 

heat and mass transfer, the term "convection" is used to refer to the sum of adjectives 

and diffusive transfer. 

Radiation is the electromagnetic waves that directly transport energy through space. 

Radiation, as used in physics, is energy in the form of waves or moving subatomic 

particles emitted by an atom or other body as it changes from a higher energy state to a 

lower energy state [ 15]. 
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2.4 Finite Element Analysis (FEA) 

FEA uses a complex system of points called nodes which make a grid called a 

mesh. This mesh is programmed to contain the material and structural properties which 

define how the structure will react to certain loading conditions. Nodes are assigned at a 

certain density throughout the material depending on the anticipated stress levels of a 

particular area. Regions which will receive large amounts of stress usually have a higher 

node density than those which experience little or no stress. Points of interest may 

consist of: fracture point of previously tested material, fillets, comers, complex detail, 

and high stress areas. The mesh acts like a spider web in that from each node, there 

extends a mesh element to each of the adjacent nodes. This web of vectors is what 

carries the material properties to the object, creating many elements [13]. However, 

batch file method will be used in this project. ANSYS batch file is a series of command 

listing. Tasks to be performed in ANSYS will be done by inputting the appropriate 

commands. All of the commands are recorded in the input history file. 

11 



CHAPTER3 

METHODOLOGY 

3.1 Procedure Identification 

Procedures to be employed in this project are clearly illustrated in Figure 5 below. 

Research! Analysis 
To find the raw data (see Appendix I) for the reformer tube 

... 
Recap/Learning 

Recall and further learn on the software program to be used 
in this nroiect. 

• 
Modeling 

To model the mechanical and thermal loadings present in 
the tuhe . 

• Simulation in ANSYS 
Simulate the stress distribution across the tube's thickness 

and length. 

1 
Assessment No 

Comparison with analytical 
result 

Yes 

Conclusion 
Draw meaningful conclusion from the numerical findings. 

Fig. 5: Schematic flow diagram of the project 
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3.2 FYP Important Milestone 

15th February 2008: Submission of Preliminary Report 

17th- 21'' March 2008: Submission ofFYP I Progress Report and Seminar. 

Week of 21 '' April 2008: Submission of Interim Report and Oral. 

15th August 2008: Submission of Progress Report 1 

8th- 12th September 2008: Submission of Progress Report 2 and Seminar. 

1Oth October 2008: Poster Exposition. 

17th October 2008: Dissertation Draft and Final Presentation. 

1Oth December 2008: Hardbound Dissertation. 

3.3 Gantt Chart 

Refer Appendix II for the Gantt charts. 

3.4 ANSYS General Procedure 

ANSYS will be used in this project. ANSYS is a comprehensive general-purpose 

finite element computer program that contains over 100,000 lines of code. ANSYS is 

capable of performing static, dynamic, heat transfer, fluid flow and electromagnetism 

analyses. 

There are three stages that are used most frequently in ANSYS: 

I. Preprocessor 

The preprocessor contains the list of commands needed to create a finite 

element model: 

a. Define element types and options 

b. Define element real constants 

c. Define material properties 

13 



At this point, physical properties of the material will be defined such 

as modulus of elasticity, Poisson's ratio, thermal conductivity and 

etc ... 

d. Create model geometry 

e. Define meshing objects 

f Mesh the object created 

II. Processor 

The next step involves applying appropriate boundary conditions and the 

proper loading. The solution processor has the commands that allow applying 

boundary conditions and loads. It includes: 

a. For structural problems: displacements, forces, pressures, temperature for 

thermal expansion 

b. For thermal problems: temperatures, heat transfer rates, convection 

surfaces, internal heat generation 

III. Postprocessor 

Postprocessors are available for review the result [ 17]. 

a. Enter the general postprocessor and read in the results 

b. Define paths 

c. List the solution 

d. Plot the stresses on every paths defined 

e. Exit the ANSYS program 

3.4.1 Coupled Analysis in ANSYS 

A sequentially coupled physics analysis is the combination of analyses from different 

engineering disciplines which interact to solve a global engineering problem. When the 

input of one physics analysis depends on the results from another analysis, the analyses 
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are coupled. The tenn sequentially coupled physics refers to solving one physics 

simulation after another. Results from one analysis become loads for the next analysis. 

The complete set of boundary conditions and loads consists of the following: 

• Base physics loads, which are not a function of other physics analyses. Such 

loads also are called nominal boundary conditions. 

• Coupled loads, which are results of the other physics simulation [ 17]. 

Thus, each different physics environment must be constructed separately so they can be 

used to detennine the coupled physics solution. By creating the geometry in the first 

physical environment, and using it with any following coupled environments, the 

geometry is kept constant [18]. 

The temperature distribution in a part can cause thennal stress effects (stresses caused 

by thennal expansion or contraction of the material). Since thennal distribution in a 

refonner tube gives big influence on the stress response, coupled field analysis can be 

used to evaluate the thennal stress of the tube. For this case, geometry will be created in 

the Thennal Environment, where the thennal effects will be applied. Although the 

geometry remains constant, the element types can change. For instance, thennal 

elements are required to detennine the stress in the refonner tube. Thennal stress effects 

of the refonner tube can be simulated by coupling a heat transfer analysis (steady-state). 

The process consists of two basic steps: 

1. A heat transfer analysis is perfonned to detennine the temperature distribution 

2. The temperature results are directly input as loads in a structural analysis to 

detennine the stress and displacement caused by the temperature load 

15 



3.5 Procedures 

The basic procedures for the physics environment approach in this problem are shown 
in Figure 6 below: 

Define table array parameters for both inner and outer temperature 

Build Geomen·y 
-Create rectangular area with thickness = 0. 01 m and length = 12.6 m 

Gene~· ate ?vlesb 
-Set preferences (axisymmetry) 

-Define the thermal element types (PLANE55) and options 
-Mesh the area 

Define Tlte~·lnal Envil·omne~tt 
-Write thermal physics file 

-Clear boundary conditions and options 

Define Sn·uchual Envinmnent 
-Write structural physics file 

Solution Pbase 
-Read thermal physics file and solve 

-Read structural physics file, read temperatures from thermal results file and 
solve 

Postprocesso1· Pbase 
-List results 
-Plot results 

Fig. 6: Procedures of using ANSYS for the project 

Refer Appendix III for procedures of using ANSYS's graphical user interface (GUI) and 

Appendix IV for input listing (batch file) of this project. 
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CHAPTER4 

RESULT AND DISCUSSION 

4.1 Data Gathering and Analysis 

4.1.1 Temperature and Pressure Profile 

All data to be used in this project referred to the thesis based on a single reformer tube 

that was retired after 90,000 hours service at Methanex Kitimat plant in British 

Columbia, Canada. The tube material is Schmidt-Clemens Centralloy® CA4852-Micro 

centrifugally cast austenitic stainless steel with physical and mechanical properties as 

showed in Table 3 below (Appendix 1 ): 

T bl 3 M t . I d h . 1 a e a ena an mec amca1 pro~ e rti fth tub es o e e 

Temperature, K 293 473 673 873 1073 1273 1373 

Young Modulus, N/m2 170e9 163e9 145e9 127e9 109e9 96e9 92e9 

Thermal conductivity, W/m.K 14.6 14.6 14.6 14.6 14.6 14.6 14.6 

Coefficient of linear expansion,lO.;;I"C 15 15.8 16 16.3 17 18.5 19 

Poisson's ratio (v) 0.3 0.3 0.3 0.3 0.3 0.3 0.3 

Density (kg/m3
) 8000 8000 8000 8000 8000 8000 8000 

The tube experienced non-uniform temperature distribution across the tube length of 

12.6 m resulted from the non-uniform heat transfer coefficient. A temperature and 

pressure profile of the reformer tube has been tabulated using Microsoft Excel based on 

the data from the failed sample (see Table 4). Profiles for the inner and outer wall 

temperatures and the internal pressure for this ex-service tube are shown in Figure 7. 
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Table 4: Data of temperature and pressure across the length of the reformer tube [11]. 

Distance Down Outer Wall Inner Wall 
Tnbe Temperature Temprature t\T Internal Pressure 

m oc oc oc Mpa 

0 656.2 576.2 80 2.239 

0.588 722.9 650.2 72.7 2.2194 

1.176 782.8 713.2 69.6 2.1998 

1.765 823.2 752.5 70.7 2.1802 

2.353 847.1 774.1 73 2.1606 

2.941 862.8 789.8 73 2.1411 

3.529 873.1 803.5 69.6 2.1215 

4 877 812.1 64.9 2.1058 

4.641 878 820.4 57.6 2.0845 

5.281 877.1 826.6 50.5 2.0631 

5.922 876.2 832.2 44 2.0418 

6.05 876.1 833.3 42.8 2.0375 

6.671 876.2 838.8 37.4 2.0169 

7.291 877 844.2 32.8 1.9962 

7.912 878.5 849.8 28.7 1.9755 

8.533 880.5 855.2 25.3 1.9549 

9.154 882.9 860.6 22.3 1.9342 

9.774 885.4 865.9 19.5 1.9135 

10.271 883.8 867.6 16.2 1.897 

10.843 882.1 869.1 13 1.878 

11.414 883.3 872 11.3 1.859 

11.986 885.5 875.4 10.1 1.84 

12.1 886 876 10 1.8361 
12.6 885.9 875.9 10 1.8199 
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Fig. 7: Temperature and pressure profile of the sample 
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Conventional steam reformers are furnaces containing tubes filled with reforming 

catalyst. Figure 8 shows a schematic lateral temperature profile inside a single reformer 

tube. 

Packed-bed tube 

.\T 

'- - -

Fig. 8: Simplified scheme of an industrial steam reformer. Lateral temperature profile 

inside a single reformer tube [16). 

4.2 Project/Problem Description 

This is an axisymmetric analysis with geometric properties and loadings showed in 

Table 5 below. Axisymmetric analysis is a problem in which the geometry, loadings, 

boundary conditions and materials are symmetric with respect to an axis is one that can 

be solved as an axisymmetric problem instead of as a three dimensional problem. 

Table 5: Geometric properties and loadings of the tube 

Geometric Properties Loadings 

Inner radius= 0.125 m T; =Refer Table 3 

Outer radius= 0.135 m To= Refer Table 3 

Length= 12.6 m Internal Pressure: Refer Table 3 

A reformer tube has temperature and pressure distribution according to Table 3 and 

Figure 7 showed above on its inner and outer surface. Figure 7 schematically presents 
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the process conditions along the length of the reformer tube that retire after 90000 hours 

of services at the Methanex Kitimat plant in British Columbia, Canada. The process 

typically enter the reformer tube between 576.2 and 656.2°C and exit at about 875.9 to 

885.9°C, with a slight pressure drop down from 2.239 .MPa to 1.89ll.MPa across the 

length of the tube. The tube metal skin temperature varies along the length of each tube 

and reflects the design of the unit, the firing configuration and the required process 

conditions. The thermal through-wall temperature gradient is greatest at the tube inlet. 

An axisymmetric model is chosen to demonstrate the thermal-stress analysis. An eight­

node quadrilateral element type PLANE55 use to model the thermal response while 

element type PLANE42 use to model the structural response. With element edge length 

of0.0004, there are 819026 nodes and 787500 elements produced in ANSYS. 

The thermal model is constructed first. Temperature constraints are applied to the inner 

and outer surface. The structural model is constructed next. Pressure constraints applied 

to the inner surface. Constraints are applied to simulate generalized plane strain 

conditions. 

The process basically requires creation of all the necessary environments, which are 

basically the preprocessing portions for each environment, and write them to memory. 

Then in the solution phase they can be combined to solve the coupled analysis.In the 

preprocessor phase, thermal analysis is identified as field #I, assigning the thermal 

element type to that field. In a similar fashion, the structural analysis is identified as 

field #2 with the structural element type assigned to that field. Field file names are 

assigned which will be used in the naming of the results files. Field #I named as thermal 

while field #2 named as structural. Since this is a static analysis, the time is set to 1.0 in 

the solution phase. The solution is then performed. 

The following assumptions are taken into consideration during the analysis: 

I. The cylinders are assumed to free to expand, generalized plane strain. 

2. There is no source of heat generation within the cylinder thickness. 
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Figure 9, 10 and 11 below show the sketch of the problem. 

(a) 

I 

I 
I 

j"Jnr;er \t'O;\\ tel'!p~rO;t\.lre 

pressure I 

I 
I 
I 

I 

(b) 

Figure 9: Problem sketch, (a) top view and (b) side view 

0.135 

0.125 

IUJIUJIUJIUJIUJIUJI[L 

Fig 10: Representative Finite Element Model illustrates the thermal and structural mesh. 

: Pressure 

: Inner Wall Temperature 

: Outer Wall Temperarure 
I 

/ 

Figure 11: Description of the model 
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4.3 Theoretical Calculation 

All results obtained in ANSYS were compared with theoretical calculations. 

4.3.1 Thermal Stresses 

Assuming a steady heat flux through the wall with aT, E and v also being constant across 

the wall, the hoop, radial and axial, thermal stresses can be approximated by: 

hoop stress: 
a - _,_aT----;E('-'--r, -------r.=-0)1 1-1n(rrr) (rrrY + 1 

hT- 2(1-v) ln(J<) (X:Y _1 

ro} (ro 1)2 

1 a E(T -T.) -In ° 'lr -
radial stress: a fF = T 

1 0 r + 
2 2(1-v) lnX: (X:) _1 

. aE(T-T.) 
axml stress: a = r ' 0 

aT 2(1- v} 
2 

(X:J -1 

4.3.2 Stresses Due to Internal Pressure 

Lame's Equations: hoop, radial and axial stresses due to internal pressure p in a long 

thick-walled cylinder: 

2 [ 2] . _pr1 r0 hoop stress. a 'P - 2 2 1 + - 2 
r0 - ri r 

2 [ 2] . p~ ~ radial stress: a 'P = 2 2 1- - 2 r0 - r, r 

2 
. I pr, 

ax1a stress: a 'P = 2 2 ro -~ 
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4.3.3 Effective Stress 

Effective stress calculated using the Von Mises criterion as follows: 

Where; 

Variables: 

o.r = coefficient of thermal expansion 

E modulus of elasticity 

v = Poisson's ratio 

r; tube internal radius 

ro tube external radius 

T; inside wall temperature 

To = outside wall temperature 

r radial distance to point of interest 

p internal pressure 

Refer Appendix V for example of theoretical calculation and Appendix VI for the rest of 

theoretical results. 

23 



4.4 Results 

t 

Following abbreviations \Vere used; 

U _X= radial displacement (m) 

s_x =radial stress (Pa) 

S_Y=a..xial stress (Pa) 

s_z =hoop stress (Pa) t 

Figure 12: Representative model of the tube showing paths where results are taken. 

4.4.1 Stress distribution across the tube's thickness 

1. At the process entry side 

Table 6: Stresses across the tube's thickness at entrance region. 

RINT ALONG PATH DEFINED BY LPATH COMMAND. DSYS= 0 

**** PATH VARIABLE SUMMARY ***** 

s 
0.0000 

0. SOOOOE-03 
0.10000E-02 
0.1SOOOE-02 
0.20000E-02 
0.2SOOOE-02 
0. 30000E-02 
0. 3 5000E-02 
0.40000E-02 
0.45000E-02 
0. 50000E-02 
0. 5 5000E-02 
0. 60000E-02 
0. 65000E-02 
O.?OOOOE-02 
0.75000E-02 
O.BOOOOE-02 
O.BSOOOE-02 
0.90000E-02 
0.95000E-02 
0.10000E-01 

XG 
0.12500 
0.12550 
0.12600 
0.12650 
0.12700 
0.12750 
0.12800 
0.12850 
0.12900 
0.12950 
0.13000 
0.13050 
0.13100 
0.13150 
0.13200 
0.13250 
0.13300 
0.13350 
0.13400 
0.13450 
0.13500 

U...X 5..)( S_ Y S...Z S_EQV 
-0.51121E-03-0.17180E+07 0.12793ET09 0.15178E+09 0.14307E+09 
-0.51396E-03-0.13397E+07 0.11415[+09 0.13753E+09 0.12B7BE+09 
-0.51665E-03-0.B1950E~6 0.10087E~9 0.12392ET09 0.11496E+09 
-0.51928E-03-0.36366E+06 0.8767BET08 0.11049ET09 0.10139ET09 
-0.52185E-03 36718, 0.74587ET08 0.97244ET08 0.88093ETOB 
-0.52434E-03 0.37160ET06 0.61652E+08 0.84218ET08 0.75149ET08 
-0.52678E-03 0.61609E.06 0.48969ET08 0.71453ETOB 0.62696ETOB 
-0.52916E-03 0.79269E+06 0.36504E+08 0.59008E+08 0.50847E+OB 
-0.53148E-03 0.980B6E+06 0.24209E+08 0.46823E+OB 0.39701E+OB 
-0.53373E-03 0.11187E+07 0.12006E+08 0.34796E+08 0.29767E+OB 
-0.53593E-03 0.12118E+07-0.12029E+06 0.22903E+08 0.22387E+08 
-0.53807E-03 0.12612E+07-0.12170E+08 0.11140E+08 0.20265E+08 
-0.54016E-03 0.12680E+07-0.24145E+08-0.49472E+06 0.24579E+08 
-0.5421BE-03 0.12264E+07-0.36035E+OB-0.11981E+08 0.32722E+08 
-0.54414E-03 0.11448E+07-0.47851E+08-0.23341E+08 0.42432E+08 
-0.54605E-03 0.10243E+07-0.59597E+08-0.34576E.08 0.52766E.08 
-Q.54791E-03 0.86617E+06-0.71273E+08-0.45685E+08 0.63348E+08 
-0,54970E-03 0.666l4E+06-0.82869E+08-0.56646E+08 0,73995E+08 
-0.55144E-03 0.43483ET06-0.94l98ET08-0.67475E+OB 0.84646ET08 
-0.55313E-03 0.16959ET06-0.10588ET09-0.78168E+08 0.95264E+08 
-0.55477E-03-0.20577ET06-0.11762ET09-0.89034E+08 0.10605ET09 
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Table 7: Result comparison between theoretical and actual Von Mises stress at the 

entrance region. 

Radial distance Von Mises Stress, S_EQV (Pa) Ratio 

across thickness (m) Theoretical ANSYS 

0.125 0.13673e9 0.14307e9 1.046 

0.1255 0.12413e9 0.12878e9 1.037 

0.126 0.11170e9 0.11496e9 1.029 

0.1265 0.99446e8 0.10139e9 1.019 

0.127 0.87396e8 0.88093e8 1.008 

0.1275 0.75581e8 0.75149e8 0.994 

0.128 0.64056e8 0.62696e8 0.979 

0.1285 0.52926e8 0.50847e8 0.961 

0.129 0.42401e8 0.39701e8 0.936 

0.1295 0.32934e8 0.29767e8 0.904 

0.13 0.25560e8 0.22387e8 0.876 

0.1305 0.22266e8 0.20265e8 0.910 

0.131 0.24583e8 0.24579e8 1.000 

0.1315 0.31168e8 0.32722e8 1.050 

0.132 0.39873e8 0.42432e8 1.064 

01325 0.49521e8 0.52766e8 1.066 

0.133 0.59600e8 0.63348e8 1.063 

0.1335 0.69875e8 0.73995e8 1.060 

0.134 0.80230e8 0.84646e8 1.055 

0.1345 0.90604e8 0.95264e8 1.051 

0.135 0.10096e9 0.10605e9 1.050 

As showed on the figure 13 below, hoop stress (SZ) and von Mises stress (SEQV) 

decrease linearly across the tube's thickness. While hoop stress continues decreasing 

linearly throughout the entire thickness, Von Mises stress starts to increase at a radial 

distance= 0.0055 meter from the inner surface. An important feature of this graph is 

that the peak stress occurs in the hoop direction which is equal to 151.83 MPa. Figure 

14(a) below showed the contour plot of von mises stress distribution at the process entry 

side. Noted that the maximum von mises stress which is equal to 143.07 MPa occur at 

the inner surface of the process entry side. 
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Figure 13 : Graph of stresses distribution at the entrance region 
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Figure 14: Contour plot of the stresses distribution at the entrance regton showmg 
maximwn Von Mises stress. 

2. At the middle length of the tube 

Table 8· Stresses distribution across the tube's thickness at the mtddle of the length. 

PRINT ALONG PATH DEFINED BY LPATH COMMAND. DSYS• 0 

••••• PATH VARIABLE SUMMARY ••••• 

S XG 
0.0000 0.12500 

0.50000E-03 0.12550 
0.10000£- 02 0.12600 
0.15000£- 02 0.12650 
0.20000£-02 0.12700 
0.25000E-02 0.12750 
0.30000£-02 0.12800 
0.35000£-02 0.12850 
0.40000£-02 0.12900 
0.45000£-02 0.12950 
0.50000£-02 0.13000 
0.55000£-02 0.13050 
0.60000£-02 0.13100 
0.65000E-02 0.13150 
0.70000£- 02 0.13200 
0.75000E-02 0.13250 
0 .80000E-02 0.13300 
0.85000£-02 0.13350 
0.90000E-02 0.13400 
0.95000E-02 0.13450 
0.10000E-01 0.13500 

u_x s_x S_Y s_z S_EQV 
-0 .21288E-04-0.20279E~7 0.57478£~8 0.84390£~8 0.76594£~8 
-0.21849E-04-0.16980E~7 0.51541£~8 0.78071£~8 0.70361£~8 
-0.22377E-04-0.13943E~7 0.45695£+08 0.71870£+08 0.64305£+08 
-0.22871E-04-0.11164E~7 0.39883£+08 0.65729£+08 0.58383£+08 
-0.23332£-04-0.86364£~6 0.34104£+08 0.59647£+08 0.52616E+08 
-0.23755E-04-0.63967E~6 0.28364ET08 0.53634ET08 0.47040ET08 
- 0.24145E-04-0.43981E+06 0.22657E+08 0.47678£+08 0.41683£+08 
-0.24503E-04-0.26358E~6 0.16982ET08 0.41780£~8 0.36606E+08 
- 0.24828E-04-0.11054E+06 0.11340ET08 0.35937£~8 0.31903ET08 
-0.25115£-04 16072. 0.57356£+07 0.30159E+08 0.27729£+08 
-0.25371£-04 0.12053£+06 0.16296£+06 0.24435£+08 0.24293£+08 
-0 .25595£-04 0.20325E+06-Q.53781E+07 0.18765£+08 0.21892£+08 
-0.25788£-04 0.26468E+06-Q.10888E+08 0.13148£+08 0.20833£+08 
-0.25943£-04 0.30180E~6-0.16361E+08 0.75914£+07 0.21266£+08 
-0.26068£-04 0.31855E+06-Q.21803E+08 0.20867£+07 0.23057£+08 
-0 .26162£- 04 0.31533E+06- 0.27215E+08-0.33672E+07 0.25886£+08 
-0.26225£- 04 0.29252E+06-Q.32596E+08-0.87709E+07 0.29423£+08 
-0 .26252£-04 0.24736E+06-Q.37942E+08- 0.14117E+08 0.33410£+08 
-0.26249£-04 0.18348E+06-Q.43258E+08-Q.19414E+08 0.37682£+08 
-0 .26215£-04 0.10124E+06-Q.48545E+08-0.24663E+08 0.42131£+08 
-0.26151£- 04 987.99 - 0.53806E+08-0.29869E+08 0.46692£+08 
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Table 9: Result comparison between theoretical and actual Von Mises stress at the 

middle ofthe tube's length. 

Radial distance Von Mises Stress, S_EQV (Pa) Ratio 

across thickness (m) Theoretical ANSYS 

0.125 0. 719lle8 0.76594e8 1.065 

0.1255 0.66323e8 0.70361e8 1.061 

0.126 0.60842e8 0.64305e8 1.057 

0.1265 0.55482e8 0.58383e8 1.052 

0.127 0.50260e8 0.52616e8 1.047 

0.1275 0.45201e8 0.47040e8 1.041 

0.128 0.40342e8 0.41683e8 1.034 

0.1285 0.35737e8 0.36606e8 1.024 

0.129 0.31471e8 0.31903e8 1.014 

0.1295 0.27665e8 0.27729e8 1.002 

0.13 0.24500e8 0.24293e8 0.992 

0.1305 0.22213e8 0.21892e8 0.986 

0.131 0.21053e8 0.20833e8 0.990 

0.1315 0.21167e8 0.21266e8 1.005 

0.132 0.22501e8 0.23057e8 1.025 

0.1325 0.24830e8 0.2.5886e8 1.043 

0.133 0.27880e8 0.29423e8 1.055 

0.1335 0.31418e8 0.33410e8 1.063 

0.134 0.35279e8 0.37682e8 1.068 

0.1345 0.39351e8 0.42131e8 1.071 

0.135 0.43560e8 0.46692e8 1.072 

The pattern of stresses distribution across the tube's thickness in middle of the tube's 

length is the same as the previous one, which is at the process entry side. As shown on 

Figure 15 below, hoop stress (SZ) and von Mises stress (SEQV) also decrease linearly 

across the tube's thickness. While hoop stress continues decreasing linearly throughout 

the entire thickness, Von Mises stress starts to increase at a radial distance= 0.006 

meter from the inner surface. It is also showed that there are only little increases for 

28 



displacement UX and radial stress (SX). The peak stress at the middle of the tube is also 

the hoop stress which is equal to 84.39 MPa. Note that the value of the peak stress is 

lower compared to the peak stress at the process entry side. 

POSTl. 

STEP..,J. 
S:UB =1. 
TIMB=l. 
PATH PLOT {><1.0..,.*4) 

8428-9:!14 

Axisymmet~ic Tube 

J\N 
NOV 30 zooe 

.u;~~z4;37 

D:tST 

Figure 15: Graph of stresses distribution at the middle length of the tube. 

3. At process exit side 

Table 10: Stress distribution across the tube's thickness at the exit region. 

PRINT ALONG PATH DEFINED BY LPATH COMMAND. DSYS= 0 

***** PATH VARIABL~ SUMMARY ***** 

S XG 
0.0000 0.12500 

0.50000E-03 0.12550 
0.10000E-02 0.12600 
O.lSOOOE-02 0.12650 
0.20000E-02 0.12700 
0.25000E-02 0.12750 
0.30000E-02 0.12800 
O.JSOOOE-02 0.12850 
0.40000E-02 0.12900 
0.45000E-02 0.12950 
0.50000E-02 0.13000 
0.55000E-02 0.13050 
0.60000E-02 0.13100 
0.65000E-02 0.13150 
0.70000E-02 0.13200 
0.75000E-02 0.13250 
O.SOOOOE-02 0.13300 
0.85000E-02 0.13350 
0.90000E-02 0.13400 
0.95000E-02 0.13450 
0.10000E-01 0.13500 

U_)( S_)( S_ Y S.2 S_EQV 
0.36605E-Q4-0.22387E+07 0.14029E+08 0.43320E+OS 0.39989E+08 
0.364B5E-04-0.20603E+07 0.12605E+08 0.41703E+OS 0.385B1E+08 
0.36374E-04-0.18899E+07 0.1118BE+08 0.40100E+08 0.37217E+08 
O.l6272E-04-0.17270E+07 0.9776BE.07 0.38511E.OB O.l5897E+OB 
0.36180E-04-0.15713E+07 O.S3717E+07 0.36936E+OB 0.34624E+08 
0.36097E-04-0.14239E+07 0.697J7E+07 0.35376E+OB 0.3340JE+08 
0.36024E-04-0.12834E+07 0.55817E+07 O.J3830E+08 0.32234E+08 
0.35959E-04-0,11497E+07 0.41957E+07 O.J2296E+OB 0.31119E+OB 
0.35902E-04-0.10227E+07 0.28156E+07 0.30775E+OS 0.30063E+OB 
0.35856E-04-0.90328E+06 0.14424E+07 0.29268E+OS 0.29070E+OB 
0.35819E-04-0.79032E+06 74931. 0.27774E+08 0.2Bl42E+08 
0.35790E-04-0.68367E+06-0.12867E+07 0.26292E+08 0.2728JE+08 
0.35769E-04-0.58321E+06-0.26427E+07 0.24822E+08 0.26496E+08 
0.3575BE-04-0.4B9B3E+06-0.39920E+07 0.23366E+OB 0.25786E+OB 
0.35755E-04-0.40240E+06-0.53357E.07 0.21922E+08 0.25157E+OB 
0.35761E-04-0.32082E+06-0.66738E.07 0.20489E+OB 0.24610E+08 
0.35774E-04-0.24497E+06-0.80064E+07 0.19068E+08 0.24148E+08 
0.35798E-04-D.l7569E+06-0.93326E+07 0.17660E+08 0.23775E+OB 
0.35829E-04-0.11191E+06-0.10653E+08 0.16263E+08 0.23492E+08 
0.35868E-04 -53467. -0.11969E+OB 0.14876E+08 0.23297E+OB 
0.35915E-04 -1238.1 -0.1327BE+08 0.13502E+08 0.23192E+08 
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Table 11: Result comparison between theoretical and actual Von Mises stress at the exit 

regwn. 

Radial distance Von Mises Stress, S_EQV (Pa) Ratio 

across thickness (m) Theoretical ANSYS 

0.125 0.33808e8 0.39989e8 1.183 

0.1255 0.32497e8 0.38581e8 1.187 

0.126 0.31227e8 0.37217e8 1.192 

0.1265 0.29999e8 0.35897e8 1.197 

0.127 0.28816e8 0.34624e8 1.201 

0.1275 0.27680e8 0.33403e8 1.207 

0.128 0.26595e8 0.32234e8 1.212 

0.1285 0.25564e8 0.31119e8 1.217 

0.129 0.24591e8 0.30063e8 1.223 

0.1295 0.23681e8 0.29070e8 1.228 

0.13 0.22838e8 0.28142e8 1.232 

0.1305 0.22067e8 0.27283e8 1.236 

0.131 0.21372e8 0.26496e8 1.240 

0 1315 0.20758e8 0.25786e8 1.242 

0.132 0.20230e8 0.25157e8 1.244 

0.1325 0.19791e8 0.24610e8 1.243 

0.133 0.19445e8 0.24148e8 1.242 

0.1335 0.19194e8 0.23775e8 1.239 

0.134 0.19038e8 0.23492e8 1.234 

01345 0.18978e8 0.23297e8 1.228 

0.135 0.190lle8 0.23192e8 1.220 

Figure 16 below showed that, at the process exit side, the hoop stress (SZ) and the von 

mises stress (SEQV) decreases across the tube's thickness. There is only a slight 

increase in the radial stress (SX). The peak value of hoop stress which is equal to 43.32 

MPa at the inner surface decreases to 13.5 MPa at the outer surface of the tube. Figure 

17 shows the von mises stress distribution at the process exit side. It can be seen that the 

inner surface experiencing higher stress compared to the outer surface which is 

experiencing minimum von mises stress. 
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Figure 17: Contour plot of Von Mises stress distribution at the exit region. 
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4.4.2 Stress distribution across the tube's length 

1. At the inner surface 

Table 12: Stress distribution on the inner surface across the tube's length. 
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Table 13: Result comparison between theoretical and actual Von Mises stress on the 

inner surface. 

Distance down the Von Mises Ratio 

tube length (m) Theoretical ANSYS 

0.00 0.13671e9 0.14307e9 1.047 

0.60 0.12600e9 0.12325e9 0.978 

1.20 0.12135e9 0.11786e9 0.971 

1.80 0.12274e9 0.11891e9 0.969 

2.60 0.12587e9 0.12123e9 0.963 

3.20 0.11368e9 0.11879e9 1.045 

3.80 0.10300e9 0.11243e9 1.092 

4.40 0.92659e8 0.10336e9 1.115 

5.00 0.83226e8 0.94118e8 1.131 

5.60 0.81489e8 0.85487e8 1.049 

6.60 0.73689e8 0.73143e8 0.993 

7.00 0.67066e8 0.69148e8 1.031 

7.60 0.61194e8 0.63745e8 1.042 

8.20 0.56335e8 0.59171e8 1.050 

8.80 0.52067e8 0.55358e8 1.063 

9.40 0.48118e8 0.51994e8 1.081 

10.00 0.43637e8 0.48261e8 1.106 

10.80 0.39368e8 0.42887e8 1.089 

11.40 0.37047e8 0.40977e8 1.106 

12.00 0.35365e8 0.39823e8 1.126 

12.60 0.35011e8 0.39989e8 1.142 

Figure 18 shows the steady state stress with the inner surface for the reformer tube along 

the length of computational region. As can be seen from this figure, the hoop stress 

values increase to the value of about y=1.26 m, then it slightly rise and decline steadily 

after y=3.15 m. The other stresses which are radial (SX) and axial (SY) stresses behaves 

in the same pattern as the hoop stress, only with lower value of stresses. 
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2. At the outer surface 

Table 14: Stress distribution on the outer surface across the tube's length. 
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Table 15. Result comparison between theoretical and actual Von Mises stress on the 

outer surface. 

Distance down the Von Mises Stress, S_EQV (Pa) Ratio 

tube length (m) Theoretical ANSYS 

10~ 0.00 0 1 0097e9 0 10605e9 

0 60 0.91143e8 0 91209e8 1 001 

1.20 0.87023e8 0.85773e8 0.986 

1.80 0 88566e8 0 85512e8 0.966 

2.60 0.87267e8 0.87571e8 1 003 

3.20 0 8098le8 0 85414e8 1 05" 

3 80 0.71277e8 0.79419e8 1.114 

4 40 0 61950e8 0 71053e8 1.147 

5 00 0.53559e8 0 62575e8 1 168 

5.60 0 52020e8 0 54705e8 I 052 

6.60 0 45259e8 0.43633e8 0 964 

7 00 0.39672e8 0 40140e8 1.012 

7.60 0 34896e8 OJ5564e8 1.019 

8.20 0 31138e8 0 31895e8 1.024 

8.80 0 28030e8 0 29068e8 I 037 

9.40 0 25370e8 0 26844e8 1 058 

10 00 0 22701e8 0 24813e8 1.093 

10 80 0 20707e8 0 23000e8 I 111 

11 40 0.19878e8 0 22865e8 I 150 

12 00 0.19380e8 0 22986e8 I 186 

12 60 0.19172e8 0 18985e8 0.990 

Figure 19 shows the steady state stress with the outer surface for the reformer tube along 

the length of computational region. As can be seen from this figure, the hoop stress 

values increase to the value ofabouty=l.26 min a compressive manner, then it is 

slightly declined and rise steadily after y=3.15 m. It is showed that the von mises stress 

distribution behaves with the opposite pattern of the hoop stress. 

36 



POST! 

STIP•1 
SUB •1 
TIHJ•1 
PATH PLOT 

l~ 

s_x 

_l. 
l.ll 

(x10 • .,.5) 

1060. St6 

61:1 . 179 

389.$04 

16$.8%9 

-281. 520 

-sos.us 

-1176.uo .._ _______________ _ 

0 2.St 5.04 7.56 10.08 12 . 6 
1 . 26 3.78 6.3 8 . 82 11.34 

DIST 

J\NO ' I .. , : ... 
NOV 30 2008 

19;49;23 

Figure 19: Stress distribution on the outer surface across the tube's length 

In the thermally developed flow of a fluid with constant properties, the heat transfer 

coefficient, h, IS constant, independent of a>dallocations, x. Because of thermal 

boundary layer thickness is smaller at the tube entrance, the convection coefficient is 

extremely large at the pipe inlet region. However, the coefficient decays rapidly as the 

thermal boundary layer develops, until the constant value associated with fully 

developed conditions IS reached. It is known that the temperature difference across the 

tube length resulted from the non-uniform heat transfer coefficient can be considerable 

causing of high thermal stresses [ 19]. 
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4.5 Comparison with yield strength of the material 

The maximum von mises stress obtained then compared with the tensile strength of the 

tube to detennme whether t he tube is able to sustain the load. Table 16 below shows the 

yield strength of the tube. 

Table 16: Yield strength of the refonner tube. 

Temperature (K) 773 873 

Yield Strength (MPa) 260 232 

973 

200 

1073 

160 

1173 

112 

The maximum von mises stress produced by the refonner tube is 143.07 MPa. The 

maxtmum von mtses stress occurred at the mner surface of the entrance reg~ on which 

operates at temperature of 849.2 K. 

As can be seen from table 16 above, since yield strength of the tube is 242.86 MPa for 

temperature equal to 849.2 K, thus the material is able to sustain the maximum von 

mises stress without fracture. 

Table 17: Comparison of max. Von Mises stress with yield strength of the tube 

Paths Temperature at Max Von Yield strength at Ratio 

Entrance 

Middle 

Exit 

Inner 

Surface 

Outer 

Surface 

which max Von Mises that temperature, 

Mises stress occur stress,<Jvm <Jy (MPa) 

(K) max (MPa) 

849.2 

1108 

1149 

849.2 

929.2 

143.07 

76.59 

39.99 

143.07 

106.05 

38 

242.86 

142.86 

121.43 

242.86 

214.29 

<Jvm mu/ <Jy 

0.588 

0.536 

0.329 

0 588 

0.495 
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Figure 20: Yield strength and max. Von Mises stress versus temperature 

Analyzing table 17 and figure 20 above, none of the von Mises stresses at those define 

paths exceeded the yield strength of the tube. Thus, the material is able to sustain the 

load at all locations. However, the possibility of failure is more likely to occur at the 

region where the process exits and the middle of the tube since the tube has the lowest 

yield strength at that locations. 
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CHAPTERS 

CONCLUSION 

In this project, the finite element method has been used to analyze thennal stress 

distribution across a single refonner tube's thickness and length. All the data used in this 

project referred to a thesis based on a single refonner tube that was retired after 90,000 

hours service at Methanex Kitimat plant in British Columbia, Canada. The tube material 

is Schmidt-Clemens Centralloy® CA4852-Micro centrifugally cast austenitic stainless 

steel. 

The data obtained in ANSYS has been compared with theoretical calculation and 

seems to agree well with each other. It has been seen that the temperature difference 

across the tube length resulted from the non-unifonn heat transfer coefficient can be 

considerable causing high thennal stresses. Maximum von mises stress equal to 142.61 

MPa developed at the inner surface of the entrance region. The stress then compared 

with the tensile strength of the tube and it is showed that the tube is able to sustain the 

stress without fracture. 
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Appendix! 

SELECTED PROPERTIES OF CENTRALLOY CA4852-MICRO 

The figures in the following pages represent typical mechanical properties of Schmidt­

Clemens Centarlloy CA4852-Micro centrifugal cast tubes. Data for CA4852-Micro 

were taken from ref [17]. In addition, other physical and mechanical properties are as 

follows: 

Density, Pt = 8000 kg/m3 

Thermal Conductivity, k1 = 14.6 W/mK 

Poisson's ratio, v = 0.3 
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Figure 1.2: Modulus of Elasticity for Schmidt-Clemens Centralloy CA4852-Micro. 
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Figure 1.3: Tensile properties for Schmidt-Clemens Centralloy CA4852-Micro. (a) Yield 

and tensile strength, (b) percentage of elongation 
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Appendix III 

Procedures of using GUI 

Define table 

I. Utility Menu> Parameters> Array Parameters> Define/Edit... The Array Parameters dialog 
box will appears. Add ... chosen. 

2. The Add New Array Parameter dialog box appears. "inner" typed in the "Parameter name" field. 
3. "Table" selected for parameter array. 
4. 24, I entered as I,J values 
5. Y entered as row variable. 
6. Click OK. 
7. In the Array Parameters dialog box, make sure inner is highlighted and click Edit. The Table 

Array: INNER=f(Y) table editor dialog box appears. 
8. Two columns appear in the table editor dialog box. The first column is column 0; the second 

column is column I. Column 0 contains 25 boxes. Do not do anything in the first (top) box. In 
the five other boxes, the tube's length increment typed. These are row index values. 

9. Column I also contains 25 boxes. The blue (top) box leave blank. In the other 24 boxes, 
temperature for every length increment's typed. 

10. Choose File> Apply/Quit. 
II. Close the Array Parameters dialog box. 
12. 12. Step 1-11 repeated for outer surface temperature. 

Thermal Environment - Create Geometry and Define Thermal Properties 

I. Give example a Title 

Utility Menu >File > Change Title . 
/title, Reformer Tube 

2. Open preprocessor menu 

ANSYS Main Menu > Preprocessor 
/PREP? 

3. Create Areas 

Preprocessor> Modeling > Create > Areas> Rectangle >By Dimensions 
RECTNG,Xl,X2,Yl,Y2 

For an axisymmetric problem, ANSYS will rotate the area around the y-axis at x=O. 

Table 5: Dimensions of the rectangle created. 

XI, X2 X-coordinates 0.125 0.135 

Yl, Y2 Y-coordinates 0 12.6 

4. Define the Type of Element 

Preprocessor >Element Type > Add/Edit/Delete ... 
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For this problem the PLANE55 (2-D, Thermal Solid) was used. PLANE55 can be used as a 
plane element or as an axisymmetric ring element with a 2-D thermal conduction capability. The 
element has four nodes with a single degree of freedom, temperature, at each node. The element 
is applicable to a 2-D, steady-state or transient thermal analysis. 

5. Turn on Axisymmetry 

This was done while the Element Types window is still open by clicking the Options button. 
Axisymmetric was selected under the Element behavior K3. 

6. Define Element Material Properties 
Preprocessor > Material Props > Material Models > Thermal > Conductivity > Isotropic 
In the window that appears, the following geometric properties entered: 

i. KXX: 14.6 

7. Define Mesh Size 
Preprocessor> Meshing > Size Cntrls >Manual Size > Areas > All Areas 
Element edge length of0.0004 was used. 

8. Mesh the frame 
Preprocessor> Meshing >Mesh> Areas >Free> click 'Pick All' 

9. Write Environment 

The thermal environment (the geometry and thermal properties) is now fully described 
and can be written to memory to be used at a later time. 
Preprocessor >Physics> Environment> Write 

In the window that appears, the TITLE Thermal entered. 

II. Clear Environment 

Preprocessor >Physics> Environment > Clear > OK 

Doing this clears all the information prescribed for the geometry, such as the element 
type, material properties, etc. It does not clear the geometry however, so it can be used 
in the next stage, which is defining the structural environment. 

Structural Environment- Define Physical Properties 

Since the geometry of the problem has already been defined in the previous steps, now all that required is 
to detail the structural variables. 

I. Switch Element Type 

Preprocessor> Element Type > Switch Elem Type 

Thermal to Struc from the scoll down list chosen. 

This will switch to the complimentary structural element automatically. In this case it is 
PLANE42. 
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Set plane strain; 

Preprocessor> Element Type > Add/Edit!Delete > Options >Element Behavior> Plane 
strain 

2. Define Element Material Properties 

Preprocessor > Material Props > Material Models > Structural > Linear > Elastic > 
Isotropic 

In the window that appears, the following geometric properties entered: 

IV. Young's Modulus EX: 

Table 6: Temperature Dependant, Young Modulus 

Temperature 293 473 673 873 1073 1273 

EX 170e9 !63e9 145e9 127e9 109e9 96e9 

ii. Poisson's Ratio PRXY: 0.3 

Preprocessor > Material Props > Material Models > Structural > Thermal Expansion 
Coef > Isotropic 

iii. ALPX: 17e-6 

3. Write Environment 

The structural environment is now fully described. 
Preprocessor> Physics >Environment >Write 

In the window that appears, the TITLE Struct entered. 

Solution Phase: Assigning Loads and Solving 

4. Define Analysis Type 

Solution > Analysis Type> New Analysis> Static 
ANTYPE,O 

2. Read in the Thermal Environment 

Solution > Unabridged Menn 

Solution> Physics> Environment > Read 

Thermal was chosen. 

3. Apply Inner Temperature 
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Solution> Define Loads > Apply> Functions> Define/Edit 

Line 4 picked on the pick menu. Select Existing table under Apply as and click OK. 
"inner" table chosen. 

4. Apply Outer Temperature 

Solution> Define Loads > Apply> Functions >Define/Edit 

Pick line 2 in the pick menu. Select Existing table under Apply as and click OK. "outer" 
table chosen. 

5. Solve the System 

Solution > Solve > Current LS 
SOLVE 

6. Close the Solution Menu 

Main Menu >Finish 

It is very important to click Finish as it closes that environment and allows a new one to 
be opened without contamination. 

The thermal solution has now been obtained. 

7. Read in the Structural Environment 

Solution > Physics > Environment > Read 

Strnct was chosen. 

8. Apply Constraints 

Solution >Define Loads > Apply > Structural >Displacement> On Lines 

Set CP~ for line 3 and UY ~o for line I. 

9. Apply Pressure 

Solution> Define Loads> Setting > For Surface Ld > Gradient 

Set; Slope~ -33e6, Slope direction~ Y 

Solution> Define Loads> Apply> Structural >Pressure > On Lines 

Line 4 picked and set pressure value~ 2.239e6. 

l 0. Include Thermal Effects 

Solution >Define Loads > Apply > Structural> Temperature >From Therm Analy 
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As shown below, the file name File.rth entered. This will couples the results from the 
solution of the thermal environment to the information prescribed in the structural 
environment and uses it during the analysis. 

II. Define Reference Temperature 

Preprocessor> Loads >Define Loads > Settings> Reference Temp 

The reference temperature set to 1153 Kelvin. 

I 0. Solve the System 

Solution > Solve > Current LS 
SOLVE 
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Input listing (batch) file 

Finish 
/clear,start 
/title, Axisymmetric Tube 

*DIM,inner,TABLE,24,1,Y 
INNER(I,O,I)~O 

INNER(2,0, !)~0.588 
INNER(3,0, 1)~1.176 
INNER(4,0,1 )~1.765 
INNER(5,0, 1)~2.353 
INNER(6,0, 1)~2.941 
INNER(7,0, 1)~3.529 
INNER(8, 0, I )~4. 000 
INNER(9,0, 1)~4.641 
INNER(IO,O,I)~5.281 

INNER( II, 0, I )~5. 922 
INNER(I2,0,1)~6.050 
INNER(13,0,1)~6.671 

INNER(I4,0,!)~7.291 

INNER(I5,0,!)~7.912 

INNER(I6,0,!)~8.533 
INNER(I7,0,1)~9.154 

INNER(I8,0,1)~9.774 

INNER(I9,0, I)~ I 0.271 
INNER(20,0,I)~10.843 

INNER(21,0, 1)~11.414 
INNER(22, 0, I)~ II. 986 
INNER(23,0,1)~J2.100 

INNER(24,0, 1)~12.600 
INNER(!, I, 1)~849.2 
INNER(2, I, I )~923 .2 
INNER(3,1,1)~986.2 

INNER(4,1, 1)~1025.5 
INNER(5,1, 1)~1047.1 
INNER(6, I, 1)~1062.8 
INNER(7,1,1)~1076.5 

INNER(8,1, 1)~1085.1 
INNER(9,1, 1)~1093.4 
INNER(IO, 1,1)~1099.6 
INNER(ll,I,I)~II05.2 

INNER(I2,1,I)~II06.3 

INNER(13, 1,1)~1111.8 
INNER(I4,1,1)~1117.2 

INNER(i5,l,IFII22.2 
INNER(I6,1,I)~JJ28.2 

INNER(l7,1,1)~1133.6 

INNER(18, I, 1)~1138.9 
INNER(19, I,IF1140.6 
INNER(20,1,1)~1142.1 

INNER(21, I, 1)~1145 

AppendixW 
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INNER(22, I, 1)'=1148.4 
INNER(23,1,1)=1149 
INNER(24,1, 1)=1148.9 

*DIM, outer, T ABLE,24, !, Y 
OUTER{I,O,!)=O 
OUTER{2,0,1)=0.588 
OUTER{3,0,1)=1.176 
OUTER(4,0, 1)=1. 765 
OUTER{5,0,1)=2.353 
OUTER{6,0,1)=2.941 
OUTER{7,0, 1)=3.529 
OUTER{8,0,1)=4.000 
OUTER(9,0,1)=4.641 
OUTER(I0,0,1)'=5.281 
OUTER{I1,0,1)=5.922 
OUTER(I2,0,1)=6.050 
OUTER(!3,0,1)=6.671 
OUTER(l4,0,1)=7.291 
OUTER(I5,0,1)=7.912 

· OUTER(16,0,1)=8.533 
OUTER(I7,0,1)=9.154 
OUTER(l8,0, 1)=9.774 
OUTER(19,0,1)=10.271 
OUTER(20,0, I)= I 0.843 
OUTER(21,0,1)=11.414 
OUTER(22,0,1)=11.986 
OUTER(23,0, 1)=12.100 
OUTER(24,0,1)=12.600 
OUTER(1,1,1)=929.2 
OUTER(2,1,1)=995.9 
OUTER(3,1,1)=1055.8 
OUTER(4,1, 1)=1096.2 
OUTER(5, I, 1)=1120.1 
OUTER(6,1,1)=1135.8 
OUTER(7,1,1)=1146.1 
OUTER(8,1,1)'=1150 
OUTER(9,1,1)=1151 
OUTER(IO,I,1)=1150.1 
OUTER(11, I, 1)=1149.2 
OUTER(I2,1,1)=1149.1 
OUTER(!3,1,1)=1149.2 
OUTER(I4, I, 1)=1150 
OUTER(15,1,1)=1151.5 
OUTER(I6, I, 1)=1153.5 
OUTER(I7, 1,1)=1155.9 
OUTER(I8, 1,1)=1158.4 
OUTER(I9, I, 1)=1156.8 
OUTER(20,1,1)=1155.1 
OUTER(21,1,1)=1156.3 
OUTER(22, I, 1)=1158.5 
OUTER(23, 1,1)=1159 
OUTER(24,1,1)=1158.9 

/prep7 
jobname ='reformer tube' 
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!MODELLING OF GEOMETRY 
rectng,0.125,0.135,0, 12.6 ! Create rectangle 
et,1,55 ! Define element type 
keyopt, 1,3, 1 ! Turns on axisymmetry 
mp,kxx,1,14.6 ! Thermal conductivity 
mp,dens, 1,8000 ! Define density 

eshape,2 
esize,0.0004 
amesh,all 

! Mesh size 
! Mesh the area 

seltol, 0.000001 
lsel,s,line,4 
dl,all,temp,%INNER%,1 
lsel,s,line,Z 
dl,all,temp,%0UTER%,1 
lsel,all 
physics,write,thermal 
physics, clear 

! Write physics environment as thermal 
! Clear the environment 

etchg,tts ! Switch element type 
et,l,42 
keyopt, 1,3, I 
mptemp, 1,293,473,673,873,1073,1273, 1373 
mpdata,ex, 1, I, 170e9, 163e9, 145e9, 127e9, I 09e9,96e9 
mpdata,prxy, I, 1, 0.3, 0.3, 0. 3, 0. 3, 0.3, 0.3, 0.3 
mptemp, 1,373,473,673,873,1073, 1273 
mpdata,alpx, 1, 1, 1.57e-5, 1.58e-5, 1.6e-5, 1.63e-5, I. 7e-5, 1.85e-5 

!Kelvin, seven temperatures 
!N/m"2 
!Poisson's ratio 

!Expansion coefficient 

seltol, 0.000001 
allsel 
nsel,s,loc,y, 12.6 
cp,l,uy,all 
nsel,s,loc,y,O 
d,all,uy,O 
nsel,all 

I To simulate Generalize plane strain - free to expand 

/pnum, line, 1 

sfgrad,pres,O,y,O,- 33261.9 
nsel,s,loc,x,0.125 
sf,all,pres,2.239e6 
allsel 
physics,write,struct 
save 
finish 

/solu 
antype,O 
physics,read,thermal 
sftran 
sbctran 
solve 
finish 

! Coupling to force to a set of node to have same DOF value 

! Tum on Line number 

! Define pressure gradient 

! Write physics environment as struct 

! Enter the solution phase 
! Steady-state analysis 
! Read in the thermal environment 
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/solu 
physics,read,struct 
ldread,temp,,,,rth 
tref, 1153 
SFTRAN 
SBCTRAN 
seltol 
solve 
finish 

/post! 
PATH,bottom,2, 
PPATH,l,O.l25,0,0 
PPATH,2,0.135,0,0 
pdef,U_X,U,X 
pdef,S_X,S,X 
pdef,S_Y,S,Y 
pdef,s_z,s,z 
pdef,S_EQV,S,EQV 
prpath,XG,U_X,S_X,S_Y,S_Z,S_EQV 
plpath,XG,U_X,S_X,S_Y,S_Z,S_EQV 

PATH,inner,2,63, 
PPATH, 1,0.125,0,0 
PPATH,2,0.125, 12.6,0 
pdef,U_X,U,X 
pdef,S _x,s,x 
pdef,S_Y,S,Y 
pdef,S_Z,S,Z 
pdef,S_EQV,S,EQV 
prpath,XG,U_X,S_X,S_Y,S_Z,S_EQV 
plpath,XG,U_X,S_X,S_Y,S_Z,S_EQV 

! Re-enter the solution phase 
! Read in the struct environment 
Apply loads derived from thermal environment 

! Transfer solid model to FE model 
! Transfer BC to FE model 

! Define path with name 
! Define path points 

! List the stress solution 

! Define path with name 
t Define path points 

! List the stress solution 
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Appendix V 

Sample calculation at the inner surface of the entrance region with: 

Inner temperature: 849.2 K 

Outer temperature: 929.2 K 

Pressure: 2. 23 9 x 106 

Radius, r: 0.125 m 

ill.I Thermal Stresses 

S _X, radial stress: 

=0 

S _ Y, axial stress: 

aE(r-r)1-21nrol 2 cr _ r , o 'lr 
aT- 2(1-v) In X (XJ -I 

a = (17xl0-6 )(ll8x109 )(849.2-929.2)[1-21n(
0

·
13%.T) _ 2 l 

aT 2(1-o.3) ln(o.B%_
125 

(o.BYo_
125

f _1 j 

= 117.568 MPa 
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S _ Z, hoop stress: 

1-ln(r%) (riJ +1 
In(){) (XJ -1 

= 117.568MPa 

ID.II Stresses Due to Internal Pressure 

S _X, radial stress: 

2 [ 2] pr, r0 
a,P= 2 2 1--2 

r0 - r, r 

a = (2.234xl0
6
)(0.125)

2 
[ 1- 0.135

2
] 

'P 0.135 2 -0.1252 0.125 2 

= -0.224MPa 

S _ Y, axial stress: 

Assume 0 (generalized plane strain condition) 

S _ Z, hoop stress: 

(2.234xl0
6 
)(0.125)

2 
[ 1 + 0.135

2
] 

0.135 2 
- 0.125 2 0.125 2 

=29.122 Mpa 
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To determine Von Mises stress, 

= 117.568 MPa + 29.122 MPa 

= 146.69MPa 

= 0 - 0.224 MPa 

= -0.224MPa 

= 117.568 MPa + 0 MPa 

= 117.568 MPa 

= ~ ~(146.69- o.224y + (- o.224 -117.568Y +(117.568 -146.69Y 

= 190.198 MPa 
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Appendix VI 

Theoretical results 

IV. I Stresses across the tube's thickness at entrance region. 

radius radiai,Sx axiai,Sy hoop,Sz Seqv 

0.125 -2.23900E+06 1.17568E+08 1.46718E+08 1.36733E+08 

0.1255 -1.67040E+06 1.05676E+08 1.34258E+08 1.24130E+08 

0.126 -1.15556E+06 9.38319E+07 1.21899E+08 1.11697E+08 

0.1265 -6.93440E+05 8.20344E+07 1.09639E+08 9.94462E+07 

0.127 -2.83032E+05 7.02834E+07 9.74775E+07 8.73964E+07 

0.1275 7.66547E+04 5.85785E+07 8.54130E+07 7.55806E+07 

0.128 3.86592E+05 4.69195E+07 7.34440E+07 6.40556E+07 

0.1285 6.47729E+05 3.53060E+07 6.15693E+07 5.29263E+07 

0.129 8.60997E+05 2.37375E+07 4.97876E+07 4.24014E+07 

0.1295 1.02731 E+06 1.22138E+07 3.80976E+07 3.29341 E+07 

0.13 1.14755E+06 7.34542E+05 2.64981 E+07 2.55595E+07 

0.1305 1.22260E+06 -1.07007E+07 1.49878E+07 2.22659E+07 

0.131 1.25331 E+06 -2.20922E+07 3.56557E+06 2 .45833E +07 

0.1315 1.24053E+06 -3.34403E+07 -7. 76975E+06 3.11682E+07 

0.132 1.18506E+06 -4.47 453E+07 -1. 90193E+07 3.98726E+07 

0.1325 1.08773E+06 -5.60076E+07 -3.01843E+07 4.9521 OE+07 

0.133 9.49307E+05 -6. 72275E+07 -4.12657E+07 5.95995E+07 

0.1335 7.70576E+05 -7.84052E+07 -5.22648E+07 6.98745E+07 

0.134 5.52289E+05 -8.95412E+07 -6.31825E+07 8.02301 E+07 

0.1345 2.95188E+05 -1.00636E+08 -7.40199E+07 9.06040E+07 

0.135 O.OOOOOE+OO -1.11689E+08 -8.47780E+07 1.00960E+08 
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IV.II Stresses distribution across the tube's thickness in the middle of the tube's length 

radius radiai,Sx axiai,Sy hoop,Sz Seqv 

0.125 -2.02900E+06 5.29380E+07 7.93540E+07 7.1911 OE+07 

0.1255 -1.71607E+06 4.75835E+07 7.36865E+07 6.63226E+07 

0.126 -1.42802E+06 4.22502E+07 6.80652E+07 6.08421E+07 

0.1265 -1.16438E+06 3.69381 E+07 6.24895E+07 5.54819E+07 

0.127 -9.24676E+05 3.16469E+07 5.69586E+07 5.02596E+07 

0.1275 -7.08455E+05 2.63765E+07 5.14720E+07 4.52005E+07 

0.128 -5. 15270E +05 2.11267E+07 4.60290E+07 4.03415E+07 

0.1285 -3.44684E+05 1 . 5897 4E +07 4.06291 E+07 3.57373E+07 

0.129 -1.96267E+05 1.06884E+07 3.52717E+07 3.14706E+07 

0.1295 -6.95995E+04 5.49959E+06 2.99562E+07 2.76649E+07 

0.13 3.57286E+04 3.30746E+05 2.46820E+07 2.45001 E+07 

0.1305 1.20120E+05 -4.81825E+06 1.94486E+07 2.22133E+07 

0.131 1.83970E+05 -9.94757E+06 1.42555E+07 2.10528E+07 

0.1315 2.27664E+05 -1.50573E+07 9.1 0202E+06 2.11667E+07 

0.132 2.51580E+05 -2.01477E+07 3.98772E+06 2.25012E+07 

0.1325 2.56090E+05 -2.52188E+07 -1.08792E+06 2.48302E+07 

0.133 2.41557E+05 -3. 02709E+07 -6.12542E+06 2.78797E+07 

0.1335 2.08336E+05 -3.53040E+07 -1.11253E+07 3.14180E+07 

0.134 1.56776E+05 -4.03182E+07 -1.60880E+07 3.52790E+07 

0.1345 8. 72190E+04 -4.53138E+07 -2.10140E+07 3.9351 OE+07 

0.135 O.OOOOOE+OO -5.02909E+07 -2.59038E+07 4.35598E+07 
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IV. III Stress distribution across the tube's thickness at the exit region. 

radius radiai,Sx axiai,Sy hoop,Sz Seqv 

0.125 -1.81990E+06 1.32015E+07 3.68952E+07 3.38075E+07 

0.1255 -1.66862E+06 1.18662E+07 3.54086E+07 3.24974E+07 

0.126 -1.52442E+06 1.05362E+07 3.39344E+07 3.12271 E+07 

0.1265 -1.38716E+06 9.21149E+06 3.24724E+07 2.99990E+07 

0.127 -1.25671 E+06 7.89199E+06 3.1 0225E+07 2.88155E+07 

0.1275 -1.13295E+06 6.57768E+06 2.95844E+07 2.76796E+07 

0.128 -1.01575E+06 5.26851 E+06 2.81581 E+07 2.65945E+07 

0.1285 -9.04989E+05 3.96444E+06 2.67432E+07 2.55637E+07 

0.129 -8.00549E+05 2.66544E+06 2.53398E+07 2.45912E+07 

0.1295 -7.02313E+05 1.37147E+06 2.39476E+07 2.36812E+07 

0.13 -6.10165E+05 8.24804E+04 2.25664E+07 2.28382E+07 

0.1305 -5.23994E+05 -1.20156E+06 2.11962E+07 2.20668E+07 

0.131 -4.43690E+05 -2.48069E+06 1.98368E+07 2.13719E+07 

0.1315 -3.69146E+05 -3.75495E+06 1.84880E+07 2.07582E+07 

0.132 -3.00255E+05 -5.02437E+06 1. 71497E+07 2.02300E+07 

0.1325 -2.36915E+05 -6.28899E+06 1.58217E+07 1.97913E+07 

0.133 -1. 79024E+05 -7. 54885E +06 1.45040E+07 1.94452E+07 

0.1335 -1.26484E+05 -8.80398E+06 1.31963E+07 1. 91939E+07 

0.134 -7.91961 E+04 -1.00544E+07 1.18986E+07 1.90382E+07 

0.1345 -3. 70660E+04 -1.13002E+07 1.06107E+07 1.89779E+07 

0.135 O.OOOOOE+OO -1.25414E+07 9.33244E+06 1.90111 E+07 
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IV.IV Stress distribution on the inner surface across the tube's length 

Distance from 
entrance radiai,Sx axiai,Sy hoop,Sz Seqv 

0.000 -2.23900E+06 1.17568E+08 1.46690E+08 1.36714E+08 

0.588 -2.21944E+06 1.06840E+08 1.35708E+08 1.25998E+08 

1.176 -2.19989E+06 1.02284E+08 1.30898E+08 1.21348E+08 

1.765 -2.18030E+06 1.03901 E+08 1.32259E+08 1.22742E+08 

2.353 -2.1607 4E+06 1.07281 E+08 1. 35385E +08 1.25869E+08 

2.941 -2.14118E+06 1.07281 E+08 1.35131 E+08 1.25683E+08 

3.529 -2.12163E+06 1.02284E+08 1.29880E+08 1.20595E+08 

4.000 -2.1 0596E+06 9.53771 E+07 1.22769E+08 1. 13681 E+08 

4.641 -2.08464E+06 8.46490E+07 1.11763E+08 1 . 03003E +08 

5.281 -2.06336E+06 7 .42148E +07 1.01052E+08 9.26592E+07 

5.922 -2.04204E+06 6.46624E+07 9.12227E+07 8.32263E+07 

6.050 -2.03778E+06 6.28989E+07 8.94038E+07 8.14888E+07 

6.050 -2.03778E+06 6.28989E+07 8.94038E+07 8.14888E+07 

6.671 -2.01713E+06 5.49631 E+07 8.11993E+07 7.36887E+07 

7.291 -1.99651E+06 4.82029E+07 7.41709E+07 6.70664E+07 

7.912 -1.97585E+06 4.21775E+07 6.78769E+07 6.11939E+07 

8.533 -1. 95520E +06 3.71809E+07 6.26116E+07 5.63348E+07 

9.154 -1.93454E+06 3.27721 E+07 5.79342E+07 5.20670E+07 

9.774 -1.91392E+06 2.86572E+07 5.35511 E+07 4.81179E+07 

10.271 -1.89739E+06 2.58650E+07 5.05438E+07 4.54416E+07 

10.271 -1 . 89739E +06 2.38075E+07 4.84864E+07 4.36367E+07 

10.843 -1.87837E+06 1.91 048E+07 4.35362E+07 3.93680E+07 

11.414 -1 . 85938E +06 1.66065E+07 4.07909E+07 3.70467E+07 

11.986 -1.84035E+06 1.48430E+07 3.87799E+07 3.53647E+07 

12.100 -1.83656E+06 1.46960E+07 3.85837E+07 3.51976E+07 

12.600 -1.81993E+06 1.47254E+07 3.83968E+07 3.501 05E+07 
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IV.V Stress distribution on the outer surface across the tube's length 

Distance from 
entrance radiai,Sx axiai,Sy hoop,Sz Seqv 

0.000 0 -1.11689E+08 -8.48039E+07 1.00968E+08 

0.588 0 -1.01497E+08 -7.48471 E+07 9.11429E+07 

1.176 0 -9.71695E+07 -7.07540E+07 8.70225E+07 

1.765 0 -9.87052E+07 -7.25249E+07 8.85663E+07 

2.353 0 -1.01916E+08 -7.59708E+07 9.17378E+07 

2.941 0 -1.01916E+08 -7.62056E+07 9.18021 E+07 

3.529 0 -9.71695E+07 -7.16937E+07 8.72666E+07 

4.000 0 -9.06078E+07 -6.53200E+07 8.09813E+07 

4.000 0 -9.06078E+07 -6.53200E+07 8.09813E+07 

4.641 0 -8.04161 E+07 -5.53844E+07 7.12768E+07 

5.281 0 -7.05037E+07 -4.57276E+07 6.19502E+07 

5.922 0 -6.14290E+07 -3.69088E+07 5.35585E+07 

6.050 0 -5.97537E+07 -3.52846E+07 5.20300E+07 

6.050 0 -5.97537E+07 -3.52846E+07 5.20300E+07 

6.671 0 -5.22146E+07 -2. 79936E+07 4.52585E+07 

7.291 0 -4.57925E+07 -2.18191E+07 3.96721 E+07 

7.912 0 -4.00685E+07 -1. 63430E +07 3.48961 E+07 

8.533 0 -3.53217E+07 -1.18443E+07 3.11376E+07 

9.154 0 -3.11333E+07 -7. 90393E +06 2.80300E+07 

9.774 0 -2. 72242E+07 -4.24242E+06 2.53704E+07 

10.271 0 -2.45716E+07 -1.78829E+06 2.37280E+07 

10.271 0 -2.26170E+07 1.66265E+05 2.27006E+07 

10.843 0 -1.81495E+07 4.40539E+06 2.07067E+07 

11.414 0 -1.57761 E+07 6.55075E+06 1.98782E+07 

11.986 0 -1.41007E+07 7.99764E+06 1. 93795E +07 

12.100 0 -1.39611 E+07 8.09173E+06 1 . 93225E +07 

12.600 0 -1.39891 E+07 7.86412E+06 1.91716E+07 
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